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Abstract: Fractional programming problems are a class of mathematical optimization challenges where the 

objective function or constraints involve rational expressions. These problems arise in various fields, 

including engineering, economics, and operations research. In this document, we explore an approach to 

solving fractional programming problems using Excel, widely available spread sheet software. The primary 

objective of this work is to present a step-by-step guide for formulating and solving fractional programming 

problems within the familiar environment of Microsoft Excel. The proposed methodology involves utilizing 

Excel's Solver add-in, a tool designed for solving optimization problems. The document outlines the process 

of transforming fractional expressions into a format that can be handled by Excel Solver, which 

predominantly deals with linear and nonlinear optimization. 

 

Index Terms - Fractional Programming Problem, MS Excel Solver, Optimal Solution,  

 

I. INTRODUCTION  

 

Fractional programming is a branch of mathematical optimization that deals with optimizing functions 

involving fractional expressions. Unlike classical optimization problems, where the objective function and 

constraints are typically composed of polynomial or linear terms, fractional programming involves ratios of 

polynomials, making it a more complex and specialized field. Fractional programming problems arise in 

various disciplines, including engineering, economics, operations research, and applied mathematics. They 

offer a powerful framework for modelling and solving real-world problems that cannot be accurately 

represented by traditional linear or nonlinear optimization techniques. Fractional programming finds 

applications in portfolio optimization, resource allocation, network design, economics, and more. Frontline 

Systems introduced the Excel Solver for the first time in 1990 as an add-in for Microsoft Excel 3.0. 

Pioneering optimization tools for spread sheets, it swiftly gained traction among numerous organizations, 

finding application across a spectrum of domains including finance, operations research, and engineering. 

Throughout its existence, the Excel Solver underwent enhancements and refinements, incorporating novel 

functionalities such as the capability to address fractional and integer-constrained problems. It also 

integrated advanced optimization techniques like evolutionary algorithms. In 2016, Microsoft acquired the 

intellectual property of the Excel Solver from Frontline Systems, incorporating it as an inherent component 

of Microsoft Excel. Since then, the Excel Solver has continued its evolution and is now ubiquitously 

embraced by enterprises and individuals on a global scale. 

 

In the present day, the Excel Solver remains an enduringly popular optimization tool for spread sheets, 

delivering a robust and versatile platform for resolving a diverse array of optimization challenges. Fractional 

programming problems encompass a mathematical optimization technique employed to address 

optimization quandaries entailing fractional objective functions and linear constraints. Unlike linear 

programming, which deals with linear functions, fractional programming problems tend to be more intricate 

and demanding due to their reliance on non-linear functions. These fractional programming issues find 
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application in myriad domains like engineering, finance, economics, operations research, and management 

science, contributing to enhanced efficiency, reduced costs, and increased profits within businesses and 

industries. Furthermore, they contribute to the optimization of system and process performance, thereby 

amplifying their efficacy and dependability. Excel Solver remains a widely-adopted instrument for tackling 

fractional programming problems, simplifying the application of such challenges across diverse domains for 

both researchers and practitioners. Consequently, the utilization of Excel Solver for optimization quandaries 

has witnessed a substantial upsurge in recent times. 

Leon O. Chua and Gui-Nian Lin (1984) ventured into a novel approach to nonlinear programming problems 

that deviates from traditional numerical computation methods. They introduce the concept of a "nonlinear 

memristor," a precursor to the now-renowned memristor device. Enrique Del Castillo & Douglas C. 

Montgomery (1993) addressed the dual response problem in quality improvement and delved into a 

nonlinear programming approach to concurrently optimize multiple responses in experimental design. 

Daniel Fylstra et al. (1998) introduced the concept of optimization problems and their prevalence in various 

fields, including engineering, finance, and logistics. Their work delves into elucidating the attributes and 

functionalities of the Solver tool—an add-in for Microsoft Excel that aids in addressing both linear and 

nonlinear optimization problems. The article outlines the installation and activation steps for Solver within 

Excel, making it accessible to users unfamiliar with the tool. Jonathan P. Pinder (2013) utilized the Excel 

Solver tool to introduce the concept of nonlinear regression in the context of decision sciences education. 

Duan, C. J., Hu, J., and Garrott, S.C. (2016) presented a case study involving the application of Excel Solver 

to resolve a truck routing problem for Braydon Farms, illustrating the pragmatic implementation of 

optimization techniques in logistics. Namrata Tripathi and Namita Srivastava (2017) explored and 

juxtaposed the usage of two distinct optimization tools, MATLAB's Optimum Toolbox and Excel Solver, 

for tackling optimization problems. Laura Briones et al. (2020) concentrated on practically demonstrating 

the application of Microsoft Excel Solver in resolving optimization problems related to distillation 

sequences. Samithamby Senthilnathan (2021) honed in on solving a linear programming problem utilizing 

the Excel Solver tool, presenting an optimal solution. 

These literature reviews offer a comprehensive panorama of Excel Solver's role in addressing fractional 

programming problems and their diversified applications. These references delve deeper into the utilization 

of Excel Solver for fractional programming issues, spotlighting a variety of domains such as mathematics, 

engineering, and education. In this paper, we extend this work for generalised fractional programming 

problem in which objective function is fractional and constraints are linear. 

 

II. Excel Solver: 

 

The MS Excel Solver serves as a widely utilized optimization tool bundled with standard installations of 

MS Excel. Developed by Frontline Systems, its purpose is to tackle optimization conundrums within an 

Excel workbook. This tool empowers users to ascertain an optimal value for a designated cell functioning as 

the objective function, while adhering to specific constraints or limitations, through the manipulation of 

decision variable cell values. The Solver model is comprised of the objective function cell, conditions, 

decision variable cells, and the interconnecting formulas. 

To arrive at solutions, the Solver employs an array of methodologies, including linear programming, 

fractional programming, and nonlinear programming, genetic and evolutionary algorithms. For q fractional 

optimization, the MS Excel Solver tool applies the generalized reduced gradient (GRG) method, as 

implemented by the GRG2 code. Linear programming relies on simplex and dual simplex methods, while 

integer-constrained issues are tackled through the branch-and-bound approach. Additionally, there exists an 

evolutionary solving method that amalgamates genetic algorithms and local search techniques to address 

non-smooth optimization challenges, an innovation pioneered by Frontline Systems. 

Nonetheless, the Excel Solver does possess limitations concerning the quantity of variables and constraints 

admissible within a model. These particular restrictions are contingent on the versions of both Excel and the 

Solver being employed. In Excel 2019, the Solver add-in can accommodate up to 200 decision variables and 

a maximum of 100 constraints. In earlier editions like Excel 2016, the add-in had more restrictive 

thresholds, accommodating merely 200 total constraints and variables combined. Furthermore, these 

thresholds may fluctuate based on the intricacy of the problem and the computational resources accessible. 

Once the quantity of variables and constraints surpasses these limits, the Solver may grapple with 

performance difficulties or may even be unable to locate a solution. 
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III. Mathematical Formulation of the Fractional Programming Problem  
 

Fractional programming is a mathematical optimization technique where the objective function or some of 

the constraints involve fractional expressions. The goal is to optimize a certain objective while considering 

these fractional components. 

The general form of a fractional programming problem is: 

Minimize or Maximize: 𝑓(𝑥) =
𝑞(𝑥)

𝑝(𝑥)
 

𝑆𝑢𝑏𝑗𝑒𝑐𝑡 𝑡𝑜: 𝑔ᵢ(𝑥)  ≤  0, 𝑓𝑜𝑟 𝑖 =  1, 2, . . . , 𝑚  
ℎⱼ(𝑥)  =  0, 𝑓𝑜𝑟 𝑗 =  1, 2, . . . , 𝑛 

where x is the vector of decision variables, 𝑝(𝑥) and 𝑞(𝑥) are polynomial functions, and 𝑔ᵢ(𝑥)  and ℎⱼ(𝑥)  
are inequality and equality constraints, respectively. 

Fractional programming problems are more complex than linear or nonlinear programming problems due to 

the presence of fractions in the objective function or constraints. Traditional optimization methods, like 

those used in linear or nonlinear programming, may not be directly applicable to fractional programming 

problems.  

Solving a fractional programming problem involves various techniques, depending on the characteristics of 

the problem and the specific algorithms used. These techniques include gradient-based methods, Newton's 

method, interior point methods, and evolutionary algorithms, among others. In practical terms, a specific 

problem's mathematical formulation may involve real-world considerations such as resource constraints, 

production limits, costs, and other factors relevant to the problem's context. The choice of optimization 

technique depends on the problem's complexity, the availability of derivatives, and the desired level of 

accuracy in the solution. 

 

IV. APPLICATIONS 
  

Fractional programming has applications in diverse fields. For instance, in finance, it can be used for 

portfolio optimization considering risk and return trade-offs. In engineering, it can help allocate resources in 

a way that maximizes efficiency while considering various constraints. 

 

V. METHODOLOGY 

 

Step 1: Installing the Solver Add-In in Microsoft Excel (One-Time Process): Launch Excel and navigate to 

the "File" tab on the ribbon. Click on "Options" located at the bottom left corner of the window. 

From the left sidebar, select "Add-Ins." In the "Add-Ins" section, choose "Excel Add-ins" from the 

dropdown menu labelled "Manage," then click "Go..."In the Add-Ins dialog box that appears, locate and 

mark the checkbox for "Solver Add-in." Click "OK" to close the dialog box. Now see the Solver button on 

the Data tab in the ribbon. 

Step 2: Using the Solver Add-In for Fractional programming Problems we proceed to solve a Fractional 

programming problem in Excel. 

Step 3: Setting Up the Problem: Open an existing worksheet or create a new one containing the fractional 

programming problem and define the objective function, decision variables, constraints, and any necessary 

parameters for proposed problem. 

Step 4: Using the Solver: Click on the "Solver" button on Windows or go to the "Data" menu and select 

"Solver." In the Solver Parameters dialog box that appears, specify whether the objective function should be 

maximized or minimized. Define the cells representing the decision variables and set the cells for limit 

constraints and also set additional options as needed. Click the "Add" button to include constraints if 

required. 

Step 5: Configuring Solver Options: Click "Options" and enable the checkboxes for "Assume nonlinear 

Model" and "Assume Non-Negative" if they are applicable to proposed problem. 

Step 6: Running the Solver: Click the "Solve" button to initiate the solving process. 

The Solver will begin searching for optimal values of the decision variables that fulfil the specified 

constraints. Once Solver identifies a solution, it will present the optimal values that optimize the objective 

function and also analysis with answer report, limiting report and sensitivity report   

These steps can effectively utilize the Solver add-in in Microsoft Excel to tackle fractional programming 

problems, enabling to optimize your decisions based on defined objectives and constraints. 
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VI. ILLUSTRATIVE EXAMPLE  

 

A farmer has two fields to cultivate two types of crops: Wheat (𝑥1) and Corn (𝑥2). The farmer has limited 

amounts of water and fertilizer available for cultivation. The objective is to maximize the total profit while 

considering fractional expressions in the profit function and constraints with following problem description 

 

Max  𝑓(𝑥) = (5𝑥1 + 3𝑥2)/ (5𝑥1 + 2𝑥2 + 1) 
    Subject to    3𝑥1  + 5𝑥2  ≤ 15, (Water Constraint)    

        5x1  + 2x2  ≤  10      (Fertilizer Constraint) 

                                         x1, x2  ≥ 0   (Non-negativity)  

 

Excel Code of the Fractional Programming Problem  

Max  𝑓(𝑥) =((5*B11+3*C11)/(5*B11+2*C11+1)) 

Subject to   SUM(B6*B$11+C6*C$11) ≤15 

SUM(B7*B$11+C7*C$11) ≤ 10 

 
  

Setting Up the Problem in MS Excel 

 
 

 

Setting Up the Problem in MS Excel with Solver Parameters  
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Setting Up the Problem in MS Excel with Solver Results 

 

 

 
 

 

 
 

 

VII. FUTURE DIRECTIONS AND CHALLENGES 

 

While fractional programming provides a powerful tool for modelling and solving complex problems, 

challenges remain. Developing more efficient linearization techniques and specialized algorithms is an on-

going area of research. Additionally, integrating fractional programming into mainstream optimization 

software tools can make it more accessible to practitioners in various domains. 

 

VIII. CONCLUSION  

 

Fractional programming problems constitute a vital domain within optimization, entailing the maximization 

or minimization of an objective function under linear constraints. Excel Solver emerges as a potent resource 

for addressing such optimization quandaries, as it permits the adjustment of decision variables while 

adhering to specified limitations to achieve an optimal resolution. A comprehensive review of literature 

demonstrates the successful utilization of Excel Solver across diverse fields like engineering, finance, and 

management to address a wide spectrum of fractional programming problems. However, it's crucial to 

acknowledge that outcomes attained through Excel Solver are susceptible to the formulation of the problem, 
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the chosen solver settings, and other variables influencing the convergence of the optimization algorithm. 

Attaining optimal outcomes via Excel Solver necessitates meticulous delineation of the objective function, 

decision variables, and constraints. Additionally, selecting appropriate solver settings and validating the 

integrity of the obtained solution are equally vital. Collectively, fractional programming problems and Excel 

Solver constitute a dynamic realm of exploration, possessing the potential to furnish substantial advantages 

in varied practical contexts. Through persistent research and development, Excel Solver and analogous 

optimization tools are anticipated to take on an ever more significant role in tackling intricate optimization 

challenges spanning diverse domains. 
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